
RM Device Finder ユーザーガイド
RMシリーズ



目次
はじめに . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

"RM Device Finder"とは . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
本ガイドの表記について. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
ソフトウェアの動作環境. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
対象機種 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
接続図と機能 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
コンピューターのネットワーク設定 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

"RM Device Finder"のインストールと起動 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
"RM Device Finder"をインストールする . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
"RM Device Finder"を起動する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

"RM Device Finder"の画面 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
"Select Network Interface Card"画面 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
"RM Device Finder"メイン画面 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
"Firmware Update"画面 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

ファームウェアを更新する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Divide / Combine Room機能を使用する . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

"Divide / Combine Room Wizard". . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
"Preset Recall"画面 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23



はじめに
本書は、RMシリーズ共通のアプリケーションソフト"RM Device Finder"（V2.5.0以降）の使用方法を説明する
ものです。

"RM Device Finder"とは
"RM Device Finder"は、ネットワーク上のRMシリーズの機器を検知し、機器が持つWeb GUI "Device
Manager"をブラウザーで表示するアプリケーションソフトです。Divide / Combine Roomセットアップ機能（
複数の部屋の分割統合のためのプリセット設定）や、プリセット切り替えの動作確認を行えます。

本ガイドの表記について

商標について
• Danteは、Audinate 社の登録商標です。
• Windowsは、米国Microsoft Corporation の米国およびその他の国における登録商標です。
• その他掲載されている会社名および製品は、各社の商標および登録商標です。

本ガイドの内容について
• このソフトウェアおよびユーザーガイドの著作権は、すべてヤマハ株式会社が所有します。
• このソフトウェアおよびユーザーガイドの一部、または全部を無断で複製・改変することはできません。
• このソフトウェアおよびユーザーガイドを運用した結果およびその影響については、一切責任を負いかねま

すのでご了承ください。
• このソフトウェアおよびユーザーガイドは、改良のため予告なしに変更されることがあります。
• このソフトウェアはWindowsのタッチパネルによる操作の動作保証はしていません。
• このユーザーガイドに掲載されているイラストや画面は、すべて操作説明のためのものです。
• このユーザーガイドは、Windows10での操作、画面を例に説明しています。

ソフトウェアの動作環境
このソフトウェアはWindows上で動作します。

OS Windows 10, Windows 11

.NET Framework 4.5.2以降が動作すること

お知らせ

お使いのコンピューターによっては、推奨環境以上の条件を必要とする場合があります。
ソフトウェアの最新バージョンおよび動作環境については、ヤマハウェブサイトの最新情報をご参
照ください。

ヤマハウェブサイト
https://download.yamaha.com

はじめに
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対象機種
バージョン2.0.0.0以降の"RM Device Finder"の機能を十分に活用するためには、使用する機器のファームウェ
アバージョンが以下の条件を満たしている必要があります。"RM Device Finder"を使用して最新のファームウ
ェアにアップデートしてください。

機種 バージョン

RM-CR 1.0.1以降

RM-CG 1.0.1以降

RM-TT 1.1.0以降

RM-WAP16 1.8.3以降

RM-WAP8 1.8.0以降

VXL1-16P 1.1.0以降

お知らせ

• Divide / Combine Room機能を使用するには、ADECIAバージョン2.0.0以降のファームウェアが
必要です。

• VXL1-16PのDanteモジュールをアップデートするには、ADECIAバージョン2.5.0以降のファー
ムウェアが必要です。

はじめに
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接続図と機能
機器の接続例と、"RM Device Finder"がサポートする機能について説明します。

※①の接続について
以下の条件を同時に満たす場合は、①の接続が必要です。

• Web GUI "RM-CR Device Manager"の"ETHERNET SWITCH SETTINGS"が"Separated"モードの場合
• RM-CRの[Dante]端子と[Corporate]端子を同じIPセグメントに設定する場合

機能 RM-CR RM-CG RM-TT RM-WAP RM-WCH RM-WOM
*1

VXL1-16P

機器検知 ✓ ✓ ✓ ✓ — — ✓

Web GUIの起動 ✓ ✓ ✓ ✓ — — —

ファームウェアのアッ
プデート

✓ ✓ ✓ ✓ *2 *2 ✓

Divide / Combine
Roomのセットアップ

✓ ✓ ✓ ✓ *3 *3 ✓

プリセット切り替えの
確認

✓ ✓ ✓ ✓ *3 *3 ✓

*1：RM-WOM/WDR/WGL/WGSの4機種
*2："RM Device Finder"から起動したWeb GUI "RM-WAP Device Manager"から行います
*3：RM-WAP の設定状態に従います。

はじめに
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コンピューターのネットワーク設定
RMシリーズのネットワークは、初期設定ではDHCPで自動的に設定されます。ネットワークにDHCPサーバーが
ない場合は、AutoIP機能が自動的にIPアドレスを割り当てます。
手動でネットワーク設定をする場合や既存のネットワークに共存させて接続する場合は、接続するLANに合わ
せて設定してください。詳しくはLANの管理者にご相談ください。

コンピューターのTCP/IPの設定
手動でネットワーク設定をする場合や既存のネットワークに共存させて接続する場合は、コンピューター
のTCP/IPを設定します。以下の手順で設定してください。

1. "コントロールパネル"を開いて、[ネットワークと共有センター]または[ネットワークの状態とタスクの表
示]をクリックします。

"ネットワークと共有センター"が表示されます。

2. "ネットワークと共有センター"の[アダプターの設定変更]をクリックし、[ローカルエリア接続]をダブルク
リックします。

"ローカルエリア接続の状態"ダイアログボックスが表示されます。
"ローカルエリア接続のプロパティ"ダイアログボックスが表示されたときは、手順4.に進みます。

3. [プロパティ]をクリックします。

"ローカルエリア接続のプロパティ"ダイアログボックスが表示されます。

4. [インターネットプロトコルバージョン4(TCP/IPv4)]を選択して、[プロパティ]をクリックします。

"インターネットプロトコルバージョン 4 (TCP/IPv4)のプロパティ"ダイアログボックスが表示されます。

5. [次のIPアドレスを使う(S)]をクリックします。
6. [IPアドレス]にコンピューターのIPアドレス、[サブネットマスク]に接続するサブネットのサブネットマス

ク、[デフォルトゲートウェイ]にゲートウェイのIPアドレスを入力します。

既存のネットワークに共存させて接続する場合、設定の詳細はLANの管理者にご相談ください。

7. [OK]をクリックします。
8. コンピューターを再起動します。

はじめに
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"RM Device Finder"のインストールと起動

"RM Device Finder"をインストールする
"RM Device Finder"のインストールファイルをPCにダウンロードし、インストールしてください。

1. ヤマハウェブサイトから、最新のインストールファイルをダウンロードします。

ヤマハウェブサイト
https://download.yamaha.com/

2. 圧縮ファイルを展開し、アプリケーションソフトをインストールします。

❶ zipファイルを任意の場所に展開します。
❷ フォルダーの中の"RMDeviceFinderInstaller.exe"ファイルをダブルクリックします。
❸ インストーラーの指示に従って、アプリケーションをインストールします。

"RM Device Finder"を起動する
以下のいずれかの方法で"RM Device Finder"を起動します。

• "RM Device Finder"のショートカットアイコンをダブルクリックする
（インストール画面で[Create a desktop shortcut]にチェックをした場合）

• Windowsのスタートアイコンからプログラムを選択する

"RM Device Finder"が起動すると、"Select Network Interface Card"画面が表示されます。

"RM Device Finder"のインストールと起動
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"RM Device Finder"の画面

"Select Network Interface Card"画面

ネットワークインターフェースカードを選択する画面です。"RM Device Finder"を起動すると表示されます。
一覧からRMシリーズを構成するネットワークインターフェースカードを1つ選択し、[OK]ボタンをクリックし
ます。

[OK]ボタンをクリックすると、"RM Device Finder"メイン画面が表示されます。

お知らせ

"RM Device Finder"メイン画面の❻ [Network]ボタンをクリックすることでも"Select Network
Interface Card"画面を表示できます。

"RM Device Finder"の画面
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"RM Device Finder"メイン画面

❶ [File]メニュー
[Firmware Update]

機器のファームウェアをアップデートするための"Firmware Update"画面を表示します。
詳しくは、"Firmware Update"画面を参照してください。
以下の方法でも"Firmware Update"画面を表示できます。

• ❼ [Firmware Update]ボタンをクリックする
[Exit]

アプリケーションを終了します。
以下の方法でもアプリケーションを終了できます。

• ウインドウの[×]ボタンをクリックする
• ➓ [Close]ボタンをクリックする

❷ [Tools]メニュー
[Preset Recall]

プリセットを呼び出すための"Preset Recall"画面を表示します。

[Divide / Combine Room Wizard]

複数の部屋の分割統合設定を行う"Divide / Combine Room Wizard"画面を表示します。
[Preset Recall]と[Divide / Combine Room Wizard]の詳細については、Divide / Combine Room機能を
使用するを参照してください。

❸ [Help]メニュー
[About]

アプリケーション名とバージョン番号を表示します。

[Legal]
本ソフトウェアが使用しているオープンソースソフトウェアのライセンス情報を表示します。

❹ "Detected Devices"一覧

検知した機器の情報を一覧表示します。
 [Web UI]アイコンが表示されている機器を選択し、[Browse]ボタンをクリックすると、Web GUI

"RM Device Finder"の画面
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"Device Manager"がブラウザーで起動します。  [Web UI]アイコンが表示されている機器の行をダブル
クリックしてもWeb GUI "Device Manager"が起動します。

お知らせ

• Web GUI "Device Manager"を表示するブラウザーは、コンピューターの設定に依存します。
• Web GUI "Device Manager"が存在しない機種は、[Web UI]アイコンが表示されません。
• RMシリーズのネットワーク対象機器のみが表示されます。

❺ [Refresh]ボタン

一覧をクリアし、機器を再検知します。
有効なネットワークインターフェースカードが選択されていないときは、[Refresh]ボタンはグレーアウト
し、クリックできません。
（クリックした後、5秒間はボタンを再度クリックできません）

❻ [Network]ボタン
ネットワークインターフェースカードを選択するための"Select Network Interface Card"画面を表示しま
す。
"Select Network Interface Card"画面は、アプリケーションの起動時にも開きます。
詳しくは、"Select Network Interface Card"画面を参照してください。

❼ [Firmware Update]ボタン

機器のファームウェアをアップデートするための"Firmware Update"画面を表示します。
詳しくは、"Firmware Update"画面を参照してください。

❽ [Identify]ボタン
一覧で選択した機器のLEDが5秒間点滅します。機器を判別するために使用します。

❾ [Browse]ボタン
一覧で選択した機器のWeb GUI "Device Manager"をブラウザーで表示します。

❿ [Close]ボタン

アプリケーションを終了します。
以下の方法でもアプリケーションを終了できます。

• ❶ [File] > [Exit]をクリックする
• ウインドウの[×]ボタンをクリックする

"RM Device Finder"の画面
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"Firmware Update"画面

❶ "Path"
選択したファームウェアファイルのパスが表示されます。

❷ […]ボタン
ファームウェアファイルを選択します。

❸ "File Info"一覧
ファームウェアファイルが対応する機種と、そのバージョン番号が表示されます。

❹ "Select Devices to Update"一覧
機器の一覧とファームウェアのアップデートの処理状況が表示されます。

Status 処理状況

Updating… ファームウェアファイルを転送している間、"Updating…"が点滅表示されます。
進捗状況は、プログレスバーで表示されます。

Success ファームウェアファイルの転送が完了し、アップデートが成功したことを示します。

Failed ファームウェアファイルの転送が完了したが、アップデートが失敗したことを示します。

Skip ファームウェアのアップデート指示に対して応答がなかった、またはファームウェアファ
イルの転送が完了したが何らかの理由でスキップしたことを示します。

Error ファイルの転送時にエラーが発生した、またはファイル送信後に機器からの応答がなかっ
たことを示します。

❺ [Refresh]ボタン
"Select Devices to Update"一覧をクリアし、機器を再検知します。

"RM Device Finder"の画面
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❻ [Network]ボタン
"Select Network Interface Card"画面を開き、ネットワークインターフェースカードを選択します。

❼ [Update]ボタン
ファームウェアアップデートを開始します。

❽ [Identify]ボタン
一覧で選択した機器のLEDが5秒間点滅します。機器を判別するために使用します。

❾ [Browse]ボタン
一覧で選択した機器のWeb GUI "Device Manager"をブラウザーで表示します。

❿ [Close]ボタン
"Firmware Update"画面を閉じます。

お知らせ

• ファームウェアのアップデート中は、いずれのボタンもクリックできません。
• RM-WCH-8、RM-WDR、RM-WOM、RM-WGS、RM-WGLは、"RM Device Finder"にてファー

ムウェアのアップデートができません。Web GUI "RM-WAP Device Manager"にてアップデー
トしてください。

• 詳しくは、RMシリーズワイヤレスマイクロフォンリファレンスマニュアルをご参照ください。

"RM Device Finder"の画面
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ファームウェアを更新する
"Firmware Update"画面で、機器のファームウェアをアップデートできます。

以下の手順で、ファームウェアをアップデートします。

1. […]ボタンをクリックして表示されるファイル選択画面から、ファームウェアのファイルを選択します。
ファームウェアのファイルは、ヤマハウェブサイトからダウンロードしてください。

ヤマハウェブサイト
https://download.yamaha.com

2. "Select Devices to Update"一覧の"Model"欄で、アップデートする機器のチェックボックスにチェックを
付けます。

3. [Update]ボタンをクリックします。
4. 画面の指示に従って、ファームウェアの更新を実行します。

完了メッセージのダイアログが表示されたら、アップデートは完了です。

ファームウェアを更新する
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Divide / Combine Room機能を使用する
1つの部屋をパーティションなどで可変的に区切ったり、複数の部屋でADECIAの機器や音声信号を共有したり
する場合に、"RM Device Finder"のDivide / Combine Room機能を使用すると、部屋の分割統合設定とその動
作確認に必要なプリセットの切り替えができます。

Divide / Combine Room機能は、以下の手順で使用します。

1. [Tools] → [Divide / Combine Room Wizard]で部屋の分割統合設定や、使用するデバイス、プリセットな
どを設定する。

2. [Tools] → [Preset Recall]で、1で設定したプリセットを呼び出す。

"Divide / Combine Room Wizard"
ウィザード画面の指示に従って設定を進めます。

"Introduction"画面
"Divide / Combine Room Wizard"の機能説明画面です。以下について説明しています。

• 最大４つの隣り合う部屋を分割または統合して使用するための設定であること。
• 部屋と使用するデバイスの設定を使用シーンに応じてプリセットとして保存できること。
• このウィザードでは、部屋の構成を決め、ネットワーク上のデバイスからRM-CRを中心にしたグルーピング

を行った後、デバイス構成の異なる複数のプリセットを作成できること。

[Next]ボタンをクリックして次の画面に進んでください。[Close]ボタンをクリックするとウィザード画面を終
了します。

Divide / Combine Room機能を使用する
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"Room Design"画面
セルをドラッグして、"Room"を作成します。最大4つの"Room"を作成できます。

[Reset]ボタンをクリックすると、作成した"Room"をすべて削除できます。
[Next]ボタンをクリックして次の画面に進んでください。
[Close]ボタンをクリックするとウィザード画面を終了します。ここまで設定したウィザードの内容を保存して
おくこともできます。

お知らせ

• 作成した"Room"を再度クリックすると"Room"を削除できます。
• "Room"をドラッグすると"Room"のサイズを拡張できます。

Divide / Combine Room機能を使用する
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"Assign Devices to the rooms"画面
ネットワーク上に検知されたRM-CRとPeripheral（マイクやスピーカーなど）がリストに表示されます。それ
ぞれのデバイスが使用される"Room"を指定します。

 （EDIT）ボタンをクリックすると、対象デバイスのHostnameを変更できます。
 （LEDインジケーター）ボタンをクリックすると、対象デバイスのLEDが点滅します。

[Reset]ボタンをクリックすると、指定した"Room"の番号がすべてクリアされます。
[Next]ボタンをクリックして次の画面に進んでください。
[Back]ボタンをクリックすると1つ前の画面に戻ります。

お知らせ

1つの部屋に設置可能なデバイスの台数は、RM-CRは最大1台、マイクは最大16台、スピーカーは
最大15台までです。また、マイクとスピーカーの合計が16台以下になるようにしてください。
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"Create room layouts"画面
部屋の間にある間仕切りボタンを操作して、想定される部屋の使い方を全て登録します。これにより部屋を分
割、統合したパターンを"Layout"として登録できます。

[Add Layout]ボタンをクリックして"Layout"を登録します。
[Remove]ボタンをクリックすると、登録した"Layout"を削除できます。
[Reset]ボタンをクリックすると、登録した"Layout"がすべて削除されます。
[Next]ボタンをクリックして次の画面に進んでください。
[Back]ボタンをクリックすると1つ前の画面に戻ります。

お知らせ

• "Layout"は10個まで登録できます。
• 同じ色の部屋は、1つの部屋として使用することを意味しています。
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"Select the Device for each combined rooms"画面
作成した"Layout"に対して、各部屋で使用するデバイスのセットを設定します。

❶ "room combination"を選択します。
❷ RM-CRを選択します。
❸ Peripheralの構成を決めます。

[Remove]ボタンをクリックすると、"room combination"からデバイスを削除できます。
[Reset]ボタンをクリックすると、設定した"room combination"がすべてクリアされます。
[Next]ボタンをクリックして次の画面に進んでください。
[Back]ボタンをクリックすると1つ前の画面に戻ります。

お知らせ

赤文字で表示された"room combination"は、利用できる最大数を超えているため調整が必要である
ことを指しています
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"Assign the speaker locations for each room combination"画面
"room combination"を選択して、Danteスピーカーのソースタイプ（L/R）を設定します。

❶ "room combination"を選択します。
❷ スピーカーの"Position"を設定します。

[Reset]ボタンをクリックすると、スピーカーのソースタイプ（L/R）設定がすべてクリアされます。
[Next]ボタンをクリックして次の画面に進んでください。
[Back]ボタンをクリックすると1つ前の画面に戻ります。
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"Create presets"画面
"Layout"のプリセット名を部屋ごとに設定します。

[Reset]ボタンをクリックすると、入力した"Preset Names"がすべてクリアされます。
[Next]ボタンをクリックして次の画面に進んでください。
[Back]ボタンをクリックすると1つ前の画面に戻ります。

お知らせ
ネットワーク上のすべてのRM-CRに対して"Layout"をプリセットとして登録します
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"Install Presets"画面
[Execute]ボタンをクリックして、作成したプリセットをネットワーク上の全てのRM-CRに登録します。登録
には、"RM-CR Device Manager"へのログインパスワードが必要です。

[Back]ボタンをクリックすると1つ前の画面に戻ります。
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完了画面

設定完了です。
[Close]ボタンをクリックしてウィザードを終了してください。
登録した設定の切り替えは、"Preset Recall"画面で行います。

お知らせ

必要に応じて、"Preset Recall"画面にてデバイス構成を各部屋に反映させた状態で音質の調整を行
い、プリセットを上書きしてください。音質の調整とプリセットの上書きには、Web GUI "Device
Manager"を使用します。
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"Preset Recall"画面
選択した複数のRM-CRに対して、同時にプリセットを呼び出すことができます。"Divide / Combine Room
Wizard"で設定したプリセットの切り替えに使用します。

❶ "RM-CR"デバイス一覧
ネットワーク上に検知したRM-CRが一覧表示されます。プリセットを呼び出すデバイスを選択します。

❷ [Select all RM-CRs]
"RM-CR"デバイス一覧に表示されている全てのRM-CRを プリセット呼び出しの対象にします。

❸ [Select a Preset Number]
呼び出すプリセット番号を選択します。

❹ [Execute]
❶ で選択したすべてのRM-CRに対して、❸ のプリセット番号を呼び出します。

❺ [Close]
"Preset Recall"画面を閉じます。
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